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Chapter 1: Request to Fulfill Value Stream with
SAP
This chapter includes:

Overview 6

Who Should Read This Guide 9

Overview
IT4IT™ is an attempt to standardize certain aspects of IT management. The IT4IT standard provides a

“reference architecture” for the IT management ecosystem, set in the context of a value chain based IT

operating model. It is intended to help organizations adapt to changes in technology, process and

methods without having to re-factor the management architecture to accommodate every shift. It is

also intended to function as design guidance for suppliers of IT management products and services.

In 2014, IT4IT was accepted by The Open Group® as a new standard being taken care of under The Open

Group. HP will further help to enhance IT4IT and create new products to support IT4IT.

For more information, see The Open Group® IT4IT™ Forum

(https://collaboration.opengroup.org/forums/it4it/).

The IT4IT Reference Architecture is fundamentally a functional model for the IT management

ecosystem. However, functional/reference models are frequently published from vendors of IT

management products. These models are often viewed as “marketecture” which is designed to

demonstrate the strengths of a vendor’s products but are too ambiguous to be implementable. Most of

these models are not based on architectural principles and/or are not connected to the broader IT

operating model that describes how the function works. Therefore, the IT4IT Forum made two

deliberate decisions; first, to design a reference model based on architectural design principles that

could be implemented and, second, to connect the reference architecture with an IT operating model

based on an industry standard construct—the Value Chain.

The Value Chain concept originated with Michael Porter in his book Competitive Advantage and focuses

on the activities by which a company adds value to an article as it flows through the production and

post-production life cycle. We combined this with the concept of value streams (James Martin: Great

Transition) to capture the customer-in perspective. The value stream concept is rooted in Lean and Six-

Sigma and emphasizes customer-oriented results.
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The IT4IT reference architecture uses the value stream construct as a way of grouping the functional

components and artifacts together to provide context for where value is being created/delivered. There

are four value streams within the model: Strategy to Portfolio, Requirement to Deploy, Request to

Fulfill, and Detect to Correct. There are also supporting functions within the value chain model such as

human resource management, legal, and finance. However, the supporting functions are not currently

modeled or reflected in the current body of work other than in some of the guidance documentation.

Here an overview of all IT4IT Reference Architecture:

Request to Fulfill Value Stream

The HP Request to Fulfill (R2F) Value Stream mainly addressed within this paper is a framework

connecting the various consumers (business users, IT practitioners, or end customers) with goods and

services that they need to drive productivity and innovation. Many IT organizations have multiple

request catalogs addressing the needs of business users, IT practitioners, or end customers. The

Request to Fulfill Value Stream brings these different request catalogs and consumer personas under a

single consumption experience using the Offer Catalog. The value stream goal is to provide a blueprint

for a unified experience that consistently engages consumers and hides the complexity of underlying

technology.

Tip: For a better understanding of this guide, go to HP Live Network and check for additional

information related to IT4IT. Check for updates in the HP Live Network Value Chain Community

(https://hpln.hp.com/group/it-value-chain). HP Live Network Value Chain Community provides more

information about the end-to-end integrated IT Value Chain and Reference Architecture.
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Tip: For a better understanding of this guide, see the HP Request to Fulfill Stream Concept and

Configuration Guide (https://softwaresupport.hp.com/group/softwaresupport/search-result/-

/facetsearch/document/KM01491937).

This technical white paper covers selected integration aspects for R2F with SAP. This document focuses

on the activities which bridge the gap between HP's Cloud Service Automation portfolio and the SAP

Installation tools.This is accomplished by integrating with the following products:

l HP Cloud Service Automation (HP CSA)

l HP Operation Orchestration (HP OO)

l HP SAP Cloud Maps (HP SAP installation content packages)

l HP Matrix Operating Environment (MOE)

Additional integrations with SAPmay be covered in future automation-related papers covering such

topics as integrating with the SAP Cloud Appliance Library, SAP Landscape Virtualization Manager, and

other SAP automation techniques. This also includes HP Cloud System version 8.x, HP Helion OpenStack,

and HP CSA Topology Designs.

Note: Throughout this document, italicized text enclosed in angle brackets (for example, "<your_

server_name>") indicates replaceable text.
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Who Should Read This Guide
This guide is intended for:

l SAP Basis experts that work with integrating SAP products with non-SAP applications and technology

l Members of the Customer SAP Competence Center or Center of Excellence

l Resource supply managers/Component designer, Service designers

l Business managers, Consumer administrators

l Operations staff

l Quality automation engineers

l IT personnel

l Network managers

l Presales and sales personnel

l IT consultants interested in SAP

l Anyone who wants to learn about the HP SAP installation automation

Note: The role(s) responsible for each action are defined at the beginning of each procedure.

Some information in this guide may duplicate information available in other Request to Fulfill Value

Stream documentation, but is provided here for convenience.
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Chapter 2: How R2F and SAP Work Together
This chapter includes:

Overview 10

Request to Fulfill Functional Components 15

Overview
The Request to Fulfill (R2F) Value Stream is meant to handle the IT automation work done on a daily

basis on all IT business services, applications, and infrastructure environments.

Applications include complex and business-critical SAP environments. Management of this business-

critical yet increasingly complex SAP environment, integrated with other non-SAP applications and

infrastructure, plus the challenge to manage modern hybrid Cloud, must be handled end-to-end.

Automated installation, scale up of SAP applications themselves is only one part of the solution—for

example, ERP, NetWeaver, Application Server, the Enterprise portal, CRM, SCM, and so on. Non-SAP

applications and infrastructure that are part of a given business process must also be deployed in

parallel to SAP deployments and often integrated with SAP systems into a landscape.

In complex customer landscapes, business services supporting critical business processes spawn

various application landscapes that include but are not limited to SAP—for example, Microsoft and self-

made applications; or industry-specific applications for manufacturing, insurance, banking, telecom,

and others.

It is mandatory for IT to have the appropriate organizational setup to align SAP teams with non-SAP and

Enterprise-oriented teams.

The overall organizational setup for a customer to manage such heterogeneous landscapes is

important—where often specific applications or layers are partly outsourced, or where services are

consumed via Cloud service provider offerings.

In large IT organizations, SAP teams are organized as a SAP Center of Excellence, with a specific focus

on SAP and appropriate SAP support integrations via their Solution Manager. Often these teams, at

least in large organizations, use Max Attention support contracts to interact with SAP Active Global

Support and to optimize their SAP specific setups, processes, and organization. These structures need

to be embedded and interlinked with the Enterprise Management groups supported by HP R2F for SAP.

There has to be a clear separation of what the team for SAP does and how the rest of the system

landscape automation and coordination is accomplished. Avoiding duplication of tasks and increased
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automation is an important business case. The efficiency benefits of doing this properly assures that

team overlap is reduced, correct experts are involved, and system interruptions are limited. It also

assures that the customer's SAP organization, with SAP Active Global Support, gets involved with only

their SAP-specific issues and that there is cross-organizational team alignment.

The following figure displays a typical SAP blueprint, with the life cycle, depicting the typical components

within a complex SAP landscape. In such a landscape, SAP applications coexist with other integrated

applications such as mail systems, SAP's Archiving Solution, Printing, Production, Procurement, Disaster

Recovery Solutions, Backup Solutions, and others. Each box shown in the figure can host several

applications from SAP and others.

In addition, all of these applications sit on top of a complex set of hardware, virtualization technology,

and software infrastructure, including the network (routers, switches, firewalls), servers (hardware and

operating system), and other software infrastructure (DNS, LDAP, and so on).

SAP customer are starting to leverage hybrid cloud (private, hosted, public) services to optimize future-

based SAP landscape setups and SAP Hana in the Enterprise Cloud Adoption. So the requirements are

increasing to automatically set up, scale up, and change landscapes.
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SAP has different tools and content packages, such as SAPINST, Software Provisioning Manager (SPM),

Cloud Appliance Libraries and installation, Landscape Virtualization Manager (LVM), and CHARM for

change management to deploy and change SAP landscapes.

This paper will mainly concentrate on the SAP INST and SAP installation images integration with the

HP R2F-related software and converged infrastructure products—especially HP Cloud System Matrix via

HP Matrix Operating Environment (MOE).

Rooted in an initiative called Reference Architecture (RA), we look at the Request to Fulfill Value Stream

and its implementation using HP Software tools in the context of the business need to automatically

deploy SAP systems and landscapes. The Request to Fulfill Value Stream provides a framework for

integrating the automation. This document addresses how this is done specifically for services enabled

via SAP tools.

Request to Fulfill with SAP Best Practices

Chapter 2: How R2F and SAPWork Together

HP Value Stream (1.3) Page 12 of 92



The following diagram is part of the software Reference Architecture core material and illustrates the

relationship between R2F's key functional components and the underpinning key artifacts. The diagram

is SAP and other vendor agnostic.
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The following diagram shows HP Software Products mapped under the Request to Fulfillment Value

Stream and how they interact with the Requirement to Deploy Value Stream and the Detect to Correct

Value Stream, as well as with SAP Solution Lifecycle (SAP LC) managed with SAP Solution Manager

Framework.

Key HP Software with SAP integrations are described within this document. In the Request to Fulfill area,

the following diagram shows an HP Software and converged infrastructure blueprint addressing the

various integrations with SAP to automate SAP deployments.
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This paper addresses the following areas:

l HP Cloud Service Automation (HP CSA)

l HP Operation Orchestration (HP OO)

l HP SAP Cloud Maps (HP SAP installation content packages)

l HP Matrix Operating Environment (MOE)

l SAPinst/Software Provision Manager (SPM)

l Integration with HP Detect to Correct (D2C) Value Stream for SAP

For more information, see the HP Detect to Correct Value Stream with SAP Best Practices Guide

(http://support.openview.hp.com/selfsolve/document/KM00840602).

Request to Fulfill Functional Components
The following detailed view of the key functional components defined in the Request to Fulfill Value

Stream serves as an overview for those readers who are not yet familiar with the HP Software Request

to Fulfill documentation.
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The functional components for this value stream are:

l Shop / Buy / Pay / Manage. Make services consumable to various classes of economic buyers and

facilitate ordering IT services, supports saving partial activities, as well as supporting service

bundles.

First, a single, unified portal where business users can request and consume both private and public

cloud services creating a one-stop shop for ordering, provisioning, and reporting on cloud services.

This makes it easier than ever before to adopt and consume hybrid cloud service no matter where

you are—your environment or the service provider's.

l Knowledge & Collaboration. Provide knowledge in the form of content and conversations that help

to address the needs of IT Service consumers. Knowledge includes structured IT/supplier produced

articles, or unstructured conversations from business/IT users, webinars, videos, training materials,

and so on.

l Catalog Aggregation & Offer Management. Aggregate the various services delivered by internal

functions and those from external supplier catalogs into consumable catalog items that can be

ordered through Shop/Buy/Pay/Manage.

Offers can be constructed based on the service catalog entries. The offer adds details on approval

and cost, as well as controls which users can consume which service.

The offer is a description of the service catalog entry, including terms and conditions, price,

configurable options, approval, SLA, and so on. You see here a relationship between an offer and

subscriptions, which says that a single offer can have many subscriptions.

l Request Rationalization. Intelligent Resource Management that automates the complex decision-

making process of identifying available resources and provisions them based on business policies,

compliance, cost and performance goals.

l Chargeback / Showback. Provide chargeback or showback for internal and external services by

consolidating service subscription and usage information.

l Catalog Composition & Design. Service catalog entries are maintained in a service catalog and

represent what can be ordered from IT. A service entry is typically constructed from a Service

Blueprint.

l Fulfillment Execution. Automated application and infrastructure provisioning deploys

infrastructure, middleware, databases, and applications. Industry best practice templates make it

easier to provide off the shelf automation templates for deploying operating systems, middleware,

and applications into public and private clouds
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Chapter 3: Use Case Implementation
This chapter includes:

Overview 17

Use Case 1: Ordering a New SAP System 17

Step 1: Use the HP CSA Marketplace Portal to Browse for SAP Services 19

Step 2: Specify the SAP Application and the SAP System ID 19

Step 3: Submit the Order Request 21

Use Case 2: Suspending and Resuming SAP System 22

Use Case 3: Adding Application Server 23

Use Case 4: Cancelling an Order for the SAP System 24

Overview
This chapter provides general instructions for ordering a new SAP Application Platform, using the HP

Cloud Service Automation (HP CSA) Services Request portal service, in order to install a new SAP Central

System (standard system), how to suspend or resume a SAP system, or cancel an order for the SAP

Central System (standard system).

Note: This information contained in this chapter is addressed from the consumer's perspective,

which is the Service Subscriber. Configuration information is available in the chapters that follow.

Use Case 1: Ordering a New SAP System
This basic use case describes how to order a SAP system on a new virtual machine provisioned for this

purpose.

This section contains the following steps:

Step 1: Use the HP CSA Marketplace Portal to Browse for SAP Services 19

Step 2: Specify the SAP Application and the SAP System ID 19

Step 3: Submit the Order Request 21
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The procedure described here will order and automatically set up a SAP Central System (standard

system). It will install a standard system with a SAP System Identifier (SID), which is a three-digit logical

name for a SAP system—for example, <SID=C10>—on a single virtual host. In a standard system, all

main instances run on a single host.

There are the following instances:

l Central services instance for ABAP (ASCS instance)

l Database instance (DB)

l Primary application server instance (PAS instance)

For more information about configuring this use case, see "Use Case Configurations" on page 40.
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Step 1: Use the HP CSA Marketplace Portal to Browse for

SAP Services

By logging on to the HP CSA Marketplace Portal (MPP), all of the SAP-related services are available for

ordering.

Step 2: Specify the SAP Application and the SAP System ID

The user needs to choose the desired SAP application, and to provide the SAP System Identifier (SID).

The SID number creates the SAP installation folder. In this example, the requester can choose only

allowed SIDs. In a more sophisticated implementation, the requester may specify allowed default

Company-specific SIDs and also add a script to validate the input and warn the subscriber. However, in

these examples, wrong SIDs lead to installation interruptions as the underlying scripts and SAP

installation programs will not allow incorrect values.

This is the System ID that will also be used as the prefix of the virtual machine host name and also the

SAP software installation folder in the file system created by the automation procedures in the

background.

Note: The Best Practices described here leverage and modify HP Operation Orchestration (HP OO)

flows to be used inside SAP Cloud Maps developed within the HP Enterprise Group SAP development

lab. This Best Practice document has the flows adjusted to match the overall HP Software-driven

best practices. The Shellscripts that perform the actual SAP deployments are also leveraged.

For additional background information and restrictions related to the original Cloud Maps flows

that are used and modified, as well as Shellscript and SAP Installation prerequisites and
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restrictions, see Implementing the HP Cloud Map for SAP Business Applications

(http://h22168.www2.hp.com/us/en/partners/sap/cloudmaps-sap.aspx).

Most of the tips and tricks to install SAP automatically will now be found in this R2F for SAP

document.

Additional information is contained in the Cloud Maps document, which was written specifically for

HP CloudSystem 7 and SAP. The Cloud Maps document may still provide add-on information, but

much of the information is CloudSystem 7 compliant and redundant for the newer technologies

that HP and SAP supply.

Listed below are examples of created SAP-related Filesystems laid out using SAP SID C10 as seen on the

screen shot of the HP CSA portal:

l /<sapmnt>/<SAPSID> > Example /sapmnt/C10

l /oracle/<DBSID> > /oracle/C10

l /usr/sap/<SAPSID> > /usr/sap/C10

The SAP SID is also used to create the naming scheme for the following SAP components:

SAP Component Hostname Pattern

Global Host <sid>glhost.<subdomain.domain>

Database <sid>dbase.<subdomain.domain>

SAP Central Services (SCS) <sid>scs.<subdomain.domain>

Central 2-Tier Installation <sid>central.<subdomain.domain>

Application Servers <sid>app<#>.<subdomain.domain>
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Note: The SID must be three characters long, starting with a capital letter (for example, A01).

By default, the content pack's SAP offerings only expose Application Name and SID as subscriber

options. All of the infrastructure details, such as the type of operation system, database vendor,

SAP flavor, and so on, are not visible to the end-user. It is recommended to create a few different

offerings with each handling a different combination of infra/application type/flavor.

Step 3: Submit the Order Request

After the service changes to the status Online, the server details and the required SAP log-on details

are displayed. Log on to MPP. Use the dashboard to navigate to More Actions > My Services.

Deployment IP Address Server IP on the public network

Host Name Server host name

Management IP Address Server IP on the internal network
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MOE Service Name Name of the service in MOE responsible for computing
the required platform for the installation

SAP Application SAP application name (based on user’s selection)

SAP Master Password During the installation, a new SAPmaster password is
generated for the special users—SAP* and DDIC. This
password can also be found in the following text file:

/sapmnt/<SID>/global/mpw.txt

Note: This is an example. In reality, this password
would be encrypted and the information sent via
appropriate tools/mails to requesting user.

SAP SW Directory Name of the directory from which the installation files
are taken

SAP System ID SAP System ID (SID) number creates the SAP
installation folders.

SAP Version Installed SAP version

Use Case 2: Suspending and Resuming SAP System
Log on to MPP. Use the dashboard to navigate to More Actions > My Services. Select the relevant

online service. Click the button to stop/start the SAP system and suspend/resume the underlying

virtual machine.

After the system is suspended, select the Resume SAP System entry to reboot the system and restore

the server.
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Use Case 3: Adding Application Server
This action executes an OO flow that is responsible for provisioning a new virtual machine (VM), copying

the installation script to that VM, and starting and conducting the SAP installation tool on it.

Click the button on the server group to deploy a new application server and copy the installation

script.

After the OO flow is completed, the new application server details are also added to the service details

page.
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Use Case 4: Cancelling an Order for the SAP System
Now the user would like to delete the installation and clean the virtual machine. He logs in to MPP and

searches for the relevant subscription he would like to delete.

To begin the deletion process, on the Subscription Details page in the MPP, click the Cancel

Subscription button. This deletes the required files and removes the virtual machine.
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Chapter 4: Configuration and Setup
This chapter includes:

Overview 25

A word about the provided content pack 26

Prerequisites 27

Hardware and Software Requirements 28

Tested Versions 28

Enterprise Hardware and Software Requirements 29

HP Cloud Service Automation – Overview 29

HP Matrix Operating Environment – Overview 29

HP Operations Orchestration – Overview 30

HP OO Central 30

HP OO Studio 30

Overview
The balance of this guide provides the information necessary to implement the integrations necessary

to achieve the provisioning of SAP using the Catalog Management and Deployment Management

capabilities of the Request to Fulfill Value Stream.

For more details on the R2F implementation, see the HP Request to Fulfill Concept and Configuration

Guide (https://softwaresupport.hp.com/group/softwaresupport/search-result/-

/facetsearch/document/KM01491937).

This document uses specific HP Matrix Operating Environment (MOE) templates and HP Operations

Orchestration (HP OO) scripts that are recommended as the best practice to implement the use cases

described herein.

Note: Throughout this document, italicized text enclosed in angle brackets (for example, "<your_

server_name>") indicates replaceable text.
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A word about the provided content pack

This package contains the following:

l SLES 2-tier_CSA.xml. MOE template responsible for allocating the required machines for central

system deployment

l SLES 3-tier_CSA.xml. MOE template responsible for allocating the required machines for

distributed system deployment

l SLES Appserver_CSA.xml. MOE template responsible for allocating the required machines for new

application server deployment

l OO1002.zip. OO project with all the related scripts to upload to the OO Studio

l SAP-cp-1.0.0.jar. OO content pack with required SAP-related flows to upload to OO Central

l oo10-csa-moe-cp-5.0.0 OO. OO content pack with MOE-related flows to upload to OO Central

l SERVICE_DESIGN_Provision_SAP_Central_System.zip. HP Cloud Service Automation (HP CSA)

sequenced design that orchestrates the MOE template and the OO flows to install SAP on a Central

System

l SERVICE_DESIGN_Provision_SAP_Distributed_System.zip. CSA sequenced design that orchestrates

the MOE template and the OO flows to install SAP on a Distributed System

l install_SAP_<version_number/script_date>.txt. SAP installation shellscript embedded on the

installation OO flow

Note: The version number and version date are included inside the script.

Using this content enables you to configure your environment to provision SAP using HP CSA version 4.x

with MOE as the resource provider.

The full use case is described in "Use Case Implementation" on page 17.
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Prerequisites
This guide expects that the following products are installed and fully functional.

Note: The installation role will be handled by the MOE Administrator, CSA Administrator, Operations

Staff, and SAP Basis Experts.

l HP Matrix Operating Environment. Server, HP Matrix IO Designer, and HP System Insight Manager

are installed.

Note: For more details and requirements for the Matrix Operating Environment, see the Cloud

Maps Overview document in the R2F – SAP Content Pack.

l HP Cloud Service Automation. Server and Client are installed.

l HP Operations Orchestration. Central and Studio are installed, including Base and CSA content

packs.
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Hardware and Software Requirements
This section includes the following topics:

Tested Versions 28

Enterprise Hardware and Software Requirements 29

Tested Versions

Note: For the hardware and software requirements, see the product documentation.

Product Version Instructions

Cloud Service Automation l 4.50 For installation instructions, see the
HP Cloud Service Automation
version 4.50 Installation Guide.

Operations Orchestration l 10.21 For installation instructions, see the
HP Operations Orchestrations version
10.2x Documentation, Videos, Best
Practices & Helpful Information.

Matrix Operating
Environment

l 7.02 or later

Recommended. 7.02

For installation instructions, see the
Matrix Operating Environment
documentation in the HP Enterprise
Information Library.

Note: Make sure that each application you install is up and running before you perform any

configuration steps.

Request to Fulfill with SAP Best Practices

Chapter 4: Configuration and Setup

HP Value Stream (1.3) Page 28 of 92

https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM01691508
https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM01691508
https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM01288353
https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM01288353
https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM01288353
http://h17007.www1.hp.com/us/en/enterprise/servers/solutions/info-library/index.aspx?cat=insightmanagement&subcat=moe#.VGyVObH8K70http://h17007.www1.hp.com/us/en/enterprise/servers/solutions/info-library/index.aspx?cat=insightmanagement&subcat=moe#.VGyVObH8K70
http://h17007.www1.hp.com/us/en/enterprise/servers/solutions/info-library/index.aspx?cat=insightmanagement&subcat=moe#.VGyVObH8K70http://h17007.www1.hp.com/us/en/enterprise/servers/solutions/info-library/index.aspx?cat=insightmanagement&subcat=moe#.VGyVObH8K70


Enterprise Hardware and Software Requirements

Note: The following tables detail the deployment environments that have been rigorously

tested by HP quality assurance personnel.

For the complete listing of hardware and software requirements, see the relevant Support Matrix

for each product.

l HP Cloud Service Automation. For more information, see the HP Cloud Service Automation

version 4.50 System and Software Support Matrix.

l HP Operations Orchestration. For more information, see the HP Operations Orchestration

version 10.20 System Requirements.

l HP Matrix Operating Environment. For more information, see the HP Insight Management

version 7.3 Update 1 Support Matrix, which includes both HP Insight Control and HP Matrix

Operating Environment.

HP Cloud Service Automation – Overview
HP Cloud Service Automation (HP CSA) is a unique platform that orchestrates the deployment of

compute and infrastructure resources and of complex multi-tier application architectures. HP CSA

integrates and leverages the strengths of several HP data center management and automation

products, adding resource management, Service Offering design, and a customer portal to create a

comprehensive service automation solution.

HP Matrix Operating Environment – Overview
The HP Matrix Operating Environment (MOE) is cloud management software for infrastructure-as-a-

service (IaaS) that increases agility and enables you to:

l Design and provision infrastructure services in minutes via a self-service portal

l Optimize infrastructure with capacity planning and showback/chargeback

l Protect service continuity with automated cost-effective failover
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The HP Matrix Operating Environment, which includes HP Insight Control, is at the core of the

HP CloudSystem Matrix, an infrastructure as a service solution for private and hybrid cloud

deployments, built on proven HP Converged Infrastructure technologies. It is available for both

HP ProLiant and HP Integrity servers, as well as for provisioning third-party x86 virtual machine

environments.

HP Operations Orchestration – Overview
HP Operations Orchestration (HP OO) is a system for creating and using actions in structured sequences

(called Ops flows, or flows) which maintain, troubleshoot, repair, and provision your IT resources by:

l Checking the health of, diagnosing and repairing, networks, servers, services, software applications

and individual workstations

l Checking client, server, and virtual machines for needed software and updates, and, if needed,

performing the necessary installations, updates, and distributions

l Performing repetitive tasks, such as checking status on internal or external Web site pages

The two main components of HP OO are Central and Studio.

HP OO Central

This is a Web-based interface in which you can:

l Run flows

l Administer the system

l Extract and analyze data resulting from the flow runs

HP OO Studio

This is a standalone authoring program in which you can:

l Create, modify, and test flows, including flows that run automatically, as scheduled

l Create new operations
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You can create operations within Studio and run them in Central. You can also create operations

that execute outside of Central in a remote action service (RAS). You do so in a development

environment that is appropriate to the task, then associate the code you have created with an

operation that you create in Studio.

l Specify which levels of users are allowed to run various parts of flows
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Chapter 5: Operating System Requirements for a
SAP Installation
Additional operating system packages, kernel settings, and other configurations are required for SAP

Business Applications.

You must have access to the SAP support web pages to view and download the SAP notes.

To access SAP support pages where SAP notes are stored, at a minimum you must be a so-called s-user

with credentials for support access. If you do not have such an account, connect to your company's SAP

super-administrator or connect to SAP and provide your company's contract information number.

Note: For Linux users, read the SAP note: 171356 - SAP Software on Linux: General information.

For example, on a Linux operating system, read at least Chapter IV of the SAP note. The following is an

overview of Chapter IV's content to provide an example of what Chapter IV covers. However, to install

SAP, it is mandatory to download SAP's latest notes.
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Chapter 6: SAP Software Depot
This chapter includes:

SAP Software Depot Creation 33

SAP Software Depot Directory Structure 36

SAP Software Depot Creation
To support repeatable, automated SAP installations, it is crucial to store all necessary installation media

at a central location—a software depot. Depending on your environment, you can host the software

depot on any server that is reachable in your environment.
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You can share the software depot on Windows through the Common Internet File System (CIFS) or on

Linux through the Network File Systems (NFS)—both described below:

1. Option: Software Depot on Windows (CIFS)

a. Create a folder on your Windows server for the software depot, such as C:\SWDEPOT.

b. To share the software depot folder, right-click SWDEPOT and select Share with > Specific

people ... as shown below.
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c. Ensure that at least one user has full access to the folder by adding an appropriate user (as

shown below) and sharing the folder.

2. Option: Software Depot on Linux (NFS)

a. Create a folder on your Linux server for the software depot.

# mkdir /SWDEPOT

b. Install the NFS Server package on your Linux host, if not already done.

c. Modify the exports file where we export our NFS share.

# vi /etc/exports
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d. Make the following entry for your share:

/SWDEPOT *(fsid=0,ro,root_squash,sync)

e. Now run exportfs to make the changes effective.

# exportfs -a

SAP Software Depot Directory Structure
Once the software depot folder has been shared, you can begin storing SAP installation media. SAP

customers can get a copy of the installation media from the SAP Service Marketplace Software

Download Center (https://support.sap.com/swdc).

Be sure to download the appropriate media archives, because some of them are operating system

dependent. For example, for SAP Business Suite 7 Innovations 2013 SR2, you must obtain the

following media:

l Operating system dependent media archives

o Software Provisioning Manager 1.0 SP09

o SAP Kernel 7.42

o Database Server for your desired databases (DB2, MaxDB, Oracle, Sybase)

l DB2 10.5

l MaxDB 7.9

l Oracle 11.2

l SAP ASE 15.7

l Operating system independent media archives

o Database Client for your desired databases (DB2, Oracle, HANA)

l DB2 10.5 - Client

l ORACLE 11.2 - Client
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l SAP HANA Platform Editon 1.0 SPS07 Rev. 74 - Client

o Installation Export for your ABAP applications (NW, ERP, CRM, SCM, SRM)

l NetWeaver 7.4 SR2 Installation Export

l SAP ERP 6.0 EHP7 SR2 Installation Export

l SAP CRM 7.0 EHP3 SR2 Installation Export

l SAP SCM 7.0 EHP3 SR2 Installation Export

l SAP SRM 7.0 EHP3 SR2 Installation Export

Create a folder for each SAP Application Suite you want to install. For our example, we created the

folder BS7i2013-SR2 in the software depot and copied the desired SAP installation media archives

there.

If the media archives have the file extension .sar, then you need the SAPCAR tool to extract them. The

SAPCAR tool is inside the Kernel archive. (This is dependent on the operating system.) If you need the

SAPCAR for another operating system, download it from the SAP Service Marketplace (service.sap.com).

The SAPCAR syntax is the same as for tar—for example, on Linux:

# ./SAPCAR –xvf your-archive-file.sar

Now you can extract the archives. Extract one archive after the other and rename the extracted folder.

For example, after the extraction of the Kernel, there will be a folder named Kernel_742-Linux and you

know what is inside this folder. Repeat this for all extracted archive files.
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After completion, you will have a folder structure similar to this for BS7i2013-SR2:
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Next, verify that the CDLABEL and LABEL files are visible inside each of these folders. Otherwise the

automated installation will fail because the SAP installer SWPM will not find the appropriate media files.

The following is an example of the content of the Kernel directory Kernel_742-Linux:
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Chapter 7: Use Case Configurations
This section contains the following topics:

Importing Templates to MOE 41

Deploying Content to HP OO Central 42

Registering Workflow to be Used in HP CSA 44

Setting System Properties in OO Central 45

Importing Sequenced Design Template to HP CSA 47

Overview 48

Creating a New Resource Provider 50

Importing an HP CSA Template 51

Connecting the Resource Offering to Resource Provider 52

Setting TemplateReference Property 52

Populating the Service Offering in HP CSA Marketplace 54

Creating a Service Offering 54

Publishing a Service Offering to the HP CSA Catalog 58
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Importing Templates to MOE

Note:

l Before importing the template, read "How to use this HP Cloud Map" in Implementing the

HP Cloud Map for SAP Business Applications

(http://h20195.www2.hp.com/V2/GetDocument.aspx?docname=4AA4-

7326ENW&cc=us&lc=en).

l The role responsible for this procedure is MOE Administrator.

The Infrastructure Orchestration (IO) template is used by HP Matrix OE (MOE) Infrastructure

Orchestration to deploy virtual and physical servers, storage, and networking suitable for a SAP

Business Applications cloud service. The template automatically deploys Linux for SAP Business

Applications.

To import the template, use the HP Matrix IO Designer. Click the Import button and select the SLES 2-

tier_CSA.xml file from the package. Repeat this action with the SLES 3-tier_CSA.xml file and SLES

Appserver_CSA.xml files.

The new templates are now added to the New Templates section.

Now the templates are ready to be used as a service in the HP Systems Insight Manager and via

HP Cloud Service Automation.
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Deploying Content to HP OO Central

Note: The role responsible for this procedure is Operations Staff.

The jar file contains the Infrastructure Orchestration cloud maps that convert to HP Operations

Orchestration (HP OO) version 10.x flows and HP Matrix Operating Environment provisioning scripts.

The SAP Flows folder contains the following:

l DNS Subflows. Supportive flows that handle the DNS when installing or deleting SAP on the virtual

machine

l MOE Deploy Subflows. Based on the HP  Infrastructure Orchestration (IO) Lifecycle folder in the

HP CSA version 4.10.0000 content pack, customizes MOE deploy scripts to provision the required

virtual machine for central installation, populates the installation properties, and updates the

HP CSA consumer page with details.

l MOE Distributed Subflows. Based on the HP  Infrastructure Orchestration (IO) Life Cycle folder in

the HP CSA version 4.10.0000 content pack, customizes MOE deploy scripts to provision the required

virtual machines for distributed installation, populates the installation properties, and updates the

CSA consumer page with details

l MOE AppServer Subflows. Based on the HP Infrastructure Orchestration (IO) Life Cycle folder in

the HP CSA version 4.10.0000 content pack, customizes MOE add server script to provision the

required virtual machine for application server, updates the CSA consumer page with details, and

executes the application server installation flow
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l SAP Central System Flows. Installs, deletes, suspends, and resumes a centralized (two tier) SAP

system with all of the SAP components (database, application server) on a single host

l SAP Distributed System Flows. Installs, deletes, suspends, and resumes a distributed (three tier)

SAP system with a different server for each of the SAP components (database, application server)

l SAP Application Server Flows. Installs, deletes, suspends, and resumes an application server with

SAP system

Note: The HP OO flows support both Linux and Windows Operating Systems, but were only tested on

Linux for the purpose of this Best Practice document.

To view the full table of tested configurations, see "Tested Configurations" on page 87.

To deploy these flows to HP OO version 10.21:

1. Log on to HP OO Central: https://<OO_server>:<port[8443]>/oo

2. Select the Content Packs tab and click the Deploy Content button.

3. On the Deploy New Content window, click the + button and select the oo10-csa-moe-cp-5.0.0 jar

file.

Note: This is in the R2F – SAP Content Pack.

4. After the file is loaded, click the Deploy button.

5. Repeat these steps with the SAP-cp-1.0.0 jar file.

Now the flows can be executed on Run Management on HP OO Central.
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Registering Workflow to be Used in HP CSA

Note: The role responsible for this procedure is Operations Staff.

Before executing flows through HP Cloud Service Automation (HP CSA), they must be imported into

HP CSA by running the Process Definition Tool. A process definition tool is set up during the installation

and configuration of HP CSA. This tool ensures that HP CSA can correctly locate the HP OO workflows

needed by the HP CSA Service Offerings.

Note: By default, the HPOOInfoInput.xml file defines the content available to HP CSA. Unless this is

changed, this is the file that needs to be configured using the Process Definition Tool.

For more details regarding importing the HP OO flows to CSA, refer to the Request to FulFill Concept

and Configuration Guide (https://softwaresupport.hp.com/group/softwaresupport/search-result/-

/facetsearch/document/KM01491937) or the HP Cloud Service Automation Installation Guide for

Windows version 4.50 (https://softwaresupport.hp.com/group/softwaresupport/search-result/-

/facetsearch/document/KM01691507).

To run the Process Definition Tool:

1. Open the following file in a text editor:

%ProgramFiles%\Hewlett-
Packard\CSA\Tools\ProcessDefinitionTool\HPOOInfoInput.xml

2. Add a new <ooengine> tag inside the <ooengines> tag.

Note: The engines will be reflected on HP CSA when choosing a script from HP OO. Separating

the <ooengine> tags to logic engines makes it easier to find the flow and reduces the loading

time.
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3. Add a link to the SAP folder and create a new <folder> tag.

<folder update="true" flow="false" path="/Library/SAP Flows" recursive="true"/>

4. Add the following links to the MOE-related folders:

<folder path="/Library/CSA/3.2/Providers/Matrix Operating Environment/HP IO
Lifecycle/Actions" update="true" flow="false" recursive="true" />

<folder path="/Library/CSA Content Pack/CSA3.2/Providers/Infrastructure/Matrix
Operating Environment/HP IO Lifecycle/Actions" recursive="true" update="true"/>

5. Run the runProcessDefinitionTool.bat file for Microsoft® SQL Server or, from C:\Program

Files\Hewlett-Packard\CSA\Tools\ProcessDefinitionTool, run the following command:

o For Oracle

java -Done-jar.class.path=ojdbc6.jar -jar process-defn-tool.jar -d
db.properties -i HPOOInfoInput.xml

o For Microsoft® SQL Server

java –jar process-defn-tool.jar –d db.properties –i HPOOInfoInput.xml

Step 5 makes the imported HP OO workflows available to HP CSA and can take several minutes to

complete. When done, the tool reports that the process definitions were created. The db.properties file

was created when HP CSA was installed and the original content was loaded.

Setting System Properties in OO Central

Note: The role responsible for this procedure is Operations Staff.

The SAP installation flow uses a few System Properties in HP OO. This chapter describes how to change

these properties.

Note: For more details about setting the system properties in OO Central, see "Implementing the

HP Cloud Map for SAP Business Applications" in HP Cloud Maps for SAP Applications

(http://h22168.www2.hp.com/us/en/partners/sap/cloudmaps-sap.aspx).

Most of the tips and tricks to install SAP automatically will now be found in this R2F for SAP

document.
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Additional information is contained in the Cloud Maps document, which was written specifically for

HP CloudSystem 7 and SAP. The Cloud Maps document may still provide add-on information, but

much of the information is CloudSystem 7 compliant and redundant for the newer technologies

that HP and SAP supply.

To set the System Properties in OO Central:

1. Log on to HP OO Central: https://<OO_server>:<port[8443]>/oo

2. Select the Content Management tab and then select the Configuration Items > System

Properties tabs:
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3. Change the following properties as shown in the following table:

Name Value Description

InstanceNumber 00 Instance Number of the SAP systems
scheduled to-be deployed

DepotHost cifs:cms.cloud.internal Protocol and hostname of the server hosting
the software depot. Protocol can be either
cifs (when using Windows shares) or nfs
(when using Linux/UNIX® shares).

SWDepotPath SWDEPOT Name of the folder on DepotHost holding the
installation media to be exported

TSIG_Key Not applicable This system property is optional. If you
protect the automatic update of your Domain
Name Service with Transaction Signatures
(TSIG), enter the key name here.

TSIG_Secret Not applicable This system property is optional. If you
protect the automatic update of your Domain
Name Service with Transaction Signatures
(TSIG), enter the key secret here.

4. Verify that DepotHost refers to the correct location of the MOE server.

Importing Sequenced Design Template to HP CSA

Note: The roles responsible for this procedure are Resource Supply Manager/Component

Designer and Service Designer.

This section contains the following topics:

Overview 48

Creating a New Resource Provider 50

Importing an HP CSA Template 51

Connecting the Resource Offering to Resource Provider 52

Setting TemplateReference Property 52
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Overview

The SEQ_DESIGN_Provision_SAP_Central_System zip file contains the sequenced design template that

is responsible for all of the services related to SAP provisioning.

The SEQ_DESIGN_Provision_SAP_Central_System design template is based on the CSA_BP_MOE_

COMPUTE_v3.20.00 template to provision a server via any MOE template with an addition of two

components consisting of a Server and an Application Layer. This HP CSA design template uses the

MOE_2-TIER_SAP resource offering that is responsible for the execution of the OO flows according to

the service life cycle.

The Deploy stage of the life cycle calls two OO flows:

l MOE Central Compute – Deploy. Script that is responsible for creating the connection between

HP CSA and MOE, and executing the required template from the templateReference property. Also

responsible for updating the hostname, IPaddress, and DeployIPaddress properties with the details

of the newly created virtual machine. This script executes on the Transition stage.
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l Install SAP Central System – CSA. Script that is responsible for the SAP installation on the created

virtual machine based on the parameters given in the design template. This script executes on the

Post Transition stage.

Another design template exists for the distributed system installation—called Provision SAP

Distributed System. The design reflects the distribution of the servers on a distributed system. This

design uses a resource offering—MOE-3-TIER-SAP—which calls the following OO flows:

l MOE Distributed Compute – Deploy. Script that is responsible for creating the connection between

CSA and MOE, and executing the required template from the templateReference property. Also

responsible for updating the hostname, IPaddress, and DeployIPaddress properties with the details

of the newly created virtual machine. This script executes on the Transition stage.
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l Install SAP Distributed System – CSA. Script that is responsible for the SAP installation on the

created virtual machine based on the parameters given in the design template. This script executes

on the Post Transition stage.

Use the following URL to enter the CSA Console to import a sequenced design template:

https://<CSA_server>:<port[8444]>/csa/dashboard/index.jsp

Creating a New Resource Provider

For a HP CSA integration with MOE, simply define a new MOE resource provider.

To create a New Resource Provider:

1. Navigate to Providers and select HP Matrix Operating Environment (MOE) as a resource provider.

2. Click the Create button.
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3. On the new window, enter all of the information required to connect to the MOE system.

Now that there is the required resource provider, import the Service Design.

Importing an HP CSA Template

This section provides general instructions for importing a Sequenced Design to HP CSA.

To import a CSA Sequenced Design template:

1. Navigate to Designs > Sequenced > Designer.

2. Click the Import button.

3. On the opened window, select the SEQ_DESIGN_Provision_SAP_Central_System zip file located in

the CSA-SAP content pack.

The design now appears on the Sequenced Designs page.

4. Repeat these steps with the SEQ_DESIGN_Provision_SAP_Distributed_System zip file located in

the CSA-SAP content pack.
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Connecting the Resource Offering to Resource Provider

As part of the import process, a new Resource Offering is created with the relevant scripts in its life

cycle.

To connect the MOE that you created as the Resource Provider to the Resource Offering

that was created:

1. Navigate to Design > Sequenced > Resource Offering.

2. Select the HP Matrix Operating Environment providers.

3. Open the MOE-2-TIER_SAP offering.

4. Navigate to the Providers tab.

5. Associate the MOE provider that you created.

6. Repeat these steps with the MOE-3-TIER-SAP resource offering.

Setting TemplateReference Property

The TemplateReference property is responsible for defining which MOE template will be executed when

submitting a new subscription.

To set the TemplateReference Property on the Provision SAP Central System design:

1. In the Provision SAP Central System, select the Designer tab.

2. Select the Infrastructure Service component and open the Properties window.
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3. Confirm that the templateReference property is set to SLES 2-tier_CSA.xml.

Note: All of the installation properties are handled at the Service Offering.

To set the TemplateReference Property on the Provision SAP Distributed System design:

1. In the Provision SAP Central System, select the Designer tab.

2. Select the Infrastructure Service component and open the Properties window.

3. Confirm that the templateReference property is set to SLES 3-tier No SAP Installation.

Once the service design is configured and before creating a service offering based on it, the service

design must be published.

To publish the service design, open it and select versions. Select the relevant version and click Publish.
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Populating the Service Offering in HP CSA Marketplace

Note: The roles responsible for this procedure are Business Manager and Consumer

Administrator.

This section includes the following topics:

Creating a Service Offering 54

Publishing a Service Offering to the HP CSA Catalog 58

Creating a Service Offering

After importing the Service Design, create a Service Offering and then place it in whichever consumer

catalog it will be offered to.

To create a Service Offering:

1. From HP CSA Console home page, select Offerings.

2. Create a new Service Offering based on the Service Design.

3. When necessary, use this page to customize the description and the image of the offering that will

be displayed in the catalog once it is published.
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4. Use the Options tab to edit all of the visible properties that are required for the installation.

Note: For more information, see the SAP Installation Guide

(https://service.sap.com/instguides). This document is available in the SAP Service

Marketplace. For access, you need minimal SAP user credentials. Contact SAP for the

credentials if you do not have them.

Check SAP Note 1680045 (https://service.sap.com/sap/support/notes/1680045) for all SAP-

supported installation options. SAP user credentials are necessary to view the page.

Property Name Description Possible Values

Application
Name

Installed SAP application Values depend on the SAP
version.

For 2013, the possible
applications are:

o SAP NetWeaver

o SAP SRM

o SAP ERP

o SAP SCM

o SAP CRM

o Solution Manager

Note: For more
options, see the SAP
installation
documentation.
Changes may be
necessary to the
shellscript.

Database
Vendor

Database for the application Values appear in a fixed list:

o Oracle

o MSSQL
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Property Name Description Possible Values

o Max-DB

o DB2

HPIO User Name User name of the MOE that executes the IO
scripts

HPIO User
Password

Password of the MOE user

Operating
System

Operating system of the server that hosts the
installation

Values appear in a fixed list:

o Linux

o Windows

SAP Flavor Programming language used by SAP Values appear in a fixed list:

o ABAP

o J2EE

SAP Installation
Directory Name

Name of the installation directory used in the
installation

List of installation directory
names depends on how you
set up your depot.

For example:

o BS7i2013-General

o BS7i2013-SR1

o and so on

SAP Version Depending on the installation directory, the
installed version of SAP

Values depend on how the
depot content is created.

For example:

o BS2013SR1

o BS2013

o and so on

SID SAP System ID: A unique string that is used as
the SID of the system, as well as the prefix of

SID must be three
characters long and start
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Property Name Description Possible Values

the hostname of the server that hosts the
installation.

with a capital letter (for
instance, T01).

Caution: Each request
must have a unique
SID.

User Name User name of the server that hosts the
installation

System administrator's
user name

For example, for Linux, the
default system
administrator User Name is
root.

User Password Password of the local operating system
administrator

System administrator's
password

Note: SAP installation
script used in the
background also
creates SAP admin and
database accounts.
Administrator has to
change these
passwords.

It is recommended to set all parameters, except SID, as invisible to the marketplace. This way you

can create a predefined Offering for the user. The design is flexible in a way that allows setting all

or part of the properties as visible to the user.
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Note: The SID property will always be open to the user so they can provide a unique ID.

The only configuration left to do is to publish the Service Offering in the desired catalog.

Publishing a Service Offering to the HP CSA Catalog

The Service Offering to the HP CSA Catalog is exposed to the relevant consumers only after it is

published. This section provides the general instructions for publishing a Service Offering to the HP CSA

Catalog.

To publish a Service Offering to the HP CSA Catalog:

1. Open SAP Service Offering.

2. Navigate to the Publishing tab.

3. In the Publish Service Offering window, select the catalog and category where the SAP Service

Offering appears.
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In this example, the Global Shared Catalog Catalog under the Compute – Private Cloud category

is selected:

The service is now ready and published in the consumer catalog.
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Chapter 8: Testing and Troubleshooting
This chapter includes:

Verifying the Service Request 60

Verifying the SAP Installation 62

Possible Errors While Importing the HP CSA Design Template 63

Possible Errors on MOE Central Compute – Deploy Script 64

Possible Errors on SAP Installation – HP CSA Script (install_SAP.sh) 65

SAP Installation Progress and Troubleshooting 66

DNS Updating Error 68

OO Flows Failed to Complete 69

CSA Service Error 70

Verifying the Service Request

Note: The roles responsible for this procedure are Consumer Administrator, Operations Staff, and

MOE Administrator.

The first check is to test that the HP Matrix Operating Environment (MOE) template and the

HP Operations Orchestration (HP OO) flows are running as expected.

To verify the service request:

1. Log on to the HP Cloud Service Automation (HP CSA) Marketplace Portal (MPP). At Shop for

Services, click the Browse Services button and select the service offering.

2. Verify that only the parameters set as visible are showing. If not, recheck the Offering setting as

described in "Populating the Service Offering in HP CSA Marketplace" on page 54.

3. Enter all of the required parameters and click the Checkout button.

4. Verify the request and click the Submit button.
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Note: It may take a fewminutes until the request changes the status to Approved, after

which continue with the verifications.

5. Log on to OO Central > Run Management and verify that MOE Central Compute – Deploy is

running

6. Log on to MOE Insight Manager and view the new request on the Requests tab.

7. Verify that a new request was created with a generated name—for example, 149ebceba782dd7.

If the new request was not created, see "Possible Errors on MOE Central Compute – Deploy Script"

on page 64.

8. After the request is complete, go back to OO Central and verify that the script completed

successfully. If the script has not completed successfully, see "Possible Errors on MOE Central

Compute – Deploy Script" on page 64

Note: It takes approximately ten minutes for the request to complete.

9. Verify that the Install SAP Central System – CSA script is running.

Note: It takes approximately 150 minutes to complete the installation.

If the script fails, see the "Possible Errors on SAP Installation – HP CSA Script (install_SAP.sh)" on

page 65 section.

10. Log on to the HP CSA Marketplace and open More Actions > My Services to view the newly created

service.

11. Verify that the service's status is in Online. If the service is not in Online status, see "CSA Service

Error" on page 70.

12. Open the service and view that the following data is available for the user:

o Virtual Machine details (hostname, IPaddress, DeployIPaddress)

o SAP Installation details [SAP System ID (SID), Instance Number, Master Password]

If the data is not presented in the service, see "Administration" on page 73.
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Verifying the SAP Installation

Note: The role responsible for this procedure is SAP Basis Expert.

Use the SAP System ID (SID), Instance Number, and Master Password that you get from the service to

check that SAP was installed based on the parameters you supplied.

To verify the SAP installation:

1. Open the SAP log-on user interface and enter the required parameters.

Note: The parameters can be found in HP Cloud Service Automation Service Details.

2. Log on with the new generated password.
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Note: The password can be found in HP Cloud Service Automation Service Details.

Possible Errors While Importing the HP CSA Design
Template

Note: The roles responsible for this procedure are Operations Staff and Service Designer.

In order for the import to complete successfully, all of the scripts that the design template is using

must be recognized by HP Cloud Service Automation.

If a script name is not recognized, the following error message is returned:

Caution: The script name may be different.
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If this error message is returned, check the following:

l If the script exists on HP Operation Orchestration Central

l If the path of the script exists on the HPOOInfoInput.xml file

If the error continues, go to the OO Studio and use the search function to check if the script exists in

another path. Then add its path to the HPOOInfoInput.xml file and run the Process Definition Tool

again—as explained in "Registering Workflow to be Used in HP CSA" on page 44.

Possible Errors onMOE Central Compute – Deploy
Script

Note: The role responsible for this procedure is Operations Staff.

When a Create IO Service failure occurs on the MOE Central Compute – Deploy script, verify the correct

inputs have been selected.

To debug the Create IO Service step:

1. Log on to HP OO Central (https://<oomachine>:8443/oo) > Run Management and select the MOE

Central Compute – Deploy run that failed.
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2. Select Step Name: Create IO Service, and verify that the following inputs are correct:

o URL. Point to the API of MOE—for example,

https://<moe.machine>51443/hpio/controller/soap/v4.

o TemplateReference. Verify that the template exists on MOE.

o SAP System ID (SID). Impacts the hostname. Verify that it is unique.

Possible Errors on SAP Installation – HP CSA Script
(install_SAP.sh)
The following errors may occur when installing the SAP System with an HP CSA Script:

SAP Installation Progress and Troubleshooting 66

DNS Updating Error 68
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SAP Installation Progress and Troubleshooting

If the installation aborts or you want to check what the installation is doing:

1. In the system preparation phase (pre-SAP installation):

a. Check /tmp/SAP_Installation.log. If the last line shows Calling sapinst…, then the system

preparation finished successfully.

b. If there are some errors, check the /tmp/SAP_Dev_Installation.log and /tmp/SAP_Error.log

files for troubleshooting.

2. In the SAP installation:

a. Check the /tmp/sapinst_instdir/sapinst_dev.log file for errors. If an exception occurred, it will

show in the last lines of the file. Make a tail -f /tmp/sapinst_instdir/sapinst_dev.log to see

what happens or search for the term ERROR in the log file.

b. If the /tmp/sapinst_instdir/summary.html file exists, the SAP installer finished the preparation

phase and is already installing the product.

c. During the import of the database content, the /tmp/sapinst_instdir/import_monitor.java.log

file can be tracked. When the import is finished, go back to sapinst_dev.log.

d. The installation finished successfully when the /tmp/sapinst_

instdir/installationSuccesfullyFinished.dat file was created.

Manual installation with SAP Installation GUI:

If an exception is returned during the automatic SAP installation, the best practice is to start the SAP

installation manually with the SAP graphical user interface and check where the installer stopped and

why. You have three options for how to accomplish that; but first stop the automated installation

process if it is still running and then check for processes called sapinst and install_sap.sh.

1. Option: The target server/virtual machine operating system has a desktop environment (X-

Window).

a. Connect to the desktop (X-Window) of your server.

b. Open a terminal as root user.
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c. Go to the installation log directory: /tmp/sapinst_instdir/.

d. Execute the SAP installer within this log directory:

/nfsmnt/<YOUR_SAP_SW_DIRECTORY>/SWPM-Linux/sapinst

The installation resumes at the point where it stopped with the problem.

2. Option: The server does not have a desktop environment, but you have another Linux host

with X-Window.

a. Connect to your server via shell.

b. Go to the installation log directory: /tmp/sapinst_instdir/.

c. Execute the SAP installer within this log directory with the parameter -nogui:

/nfsmnt/<YOUR_SAP_SW_DIRECTORY>/SWPM-Linux/sapinst -nogui

d. Connect to the desktop (X-Window) of another Linux host.

e. Open a terminal as a root user.

f. Mount the Software Depot or copy the necessary SAP SWPM (Software Provisioning Manager)

Linux bits to the system.

g. Execute the SAP graphical user interface installer:

/nfsmnt/<YOUR_SAP_SW_DIRECTORY>/SWPM-Linux/sapinstgui

h. Provide the host name of your installation server, leave the port as it is, and click Next.

i. On the next screen, enter the root credentials of the server.

The installation resumes at the point where it stopped with the problem.

3. Option: The server does not have a desktop environment, but you have a Windows system.

a. Connect to your server via shell.

b. Go to the installation log directory: /tmp/sapinst_instdir/.

c. Execute the SAP installer within this log directory with the parameter -nogui:

/nfsmnt/<YOUR_SAP_SW_DIRECTORY>/SWPM-Linux/sapinst -nogui
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d. Connect to your Windows system.

e. Mount the Software Depot or copy the necessary SAP SWPM (Software Provisioning Manager)

Windows bits to the system.

f. Execute the SAP graphical user interface installer.

Note: You need the Windows binaries of the SWPM.

Navigate to the appropriate SWPM-Windows directory and execute sapinstgui.exe.

g. Provide the host name of your installation server, leave the port as it is, and click Next.

h. On the next screen, enter the root credentials of the server.

The installation resumes at the point where it stopped with the problem.

DNS Updating Error

Note: The role responsible for this procedure is Operations Staff.

The DNS updating error may occur due to the virtual machine not being cleaned correctly from the

previous DNS name. This may happen on development and testing environments.

To correct the DNS updating error:

1. Log on to HP OO Central (https://<oomachine>:8443/oo) > Run Management and select the

Install SAP central system – CSA run that failed.
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2. Click the Update DNS Server step to view the details of the virtual machine.

3. Log on to the virtual machine that was created.

4. In the tmp folder, view the update_dns.log file and see what the expected DNS name is.

5. Log on to HP OO Central and run the Delete DNS flow.

6. Enter the expected dns name listed in the update_dns.log file on the fullhostname property.

OO Flows Failed to Complete

Note: The roles responsible for this procedure are Operations Staff and Resource Supply

Manager.

There is a situation in which the OO flow is not failing, but also cannot continue to completion. This may

happen when the CSA Service component ID did not transfer correctly to the OO flow. It is not related to

a specific flow, but to all flows that executed from CSA.

To transfer the Service Component ID to the OO flow:

1. Log on to HP CSA (https://<CSA_machine>:8444/csa/login).

2. Navigate to Designs > Sequenced > Resource Offerings.

3. Open the resource offering that is used in the design—MOE-2-TIER_SAP or MOE-3-TIER-SAP.

4. If the problem occurs in an installation flow, select the Lifecycle tab and click Deploying. Then

select the Post-Transition tab.
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5. If the problem occurs in a deletion flow, select the Lifecycle tab and click Deploying. Then select

the Pre-Transition tab.

6. Open the flow that exists on that stage.

7. Click the Properties tab and verify that the property SVC_COMPONENT_ID is set with the

[TOKEN:SVC_COMPONENT_ID].

CSA Service Error

Note: The roles responsible for this procedure are Operations Staff and Resource Supply

Manager.

There are a few factors that can cause the service to fail even if all related OO flows completed

successfully.

The first one is timeout on the CSA service. Since the installation flow usually takes more than an hour,

the timeout definition on the life cycle action may not be enough.

The second reason for the service failure is that it is missing the Update Process Instance State

component in the flow.
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To check and correct the action’s timeout on CSA:

1. Log on to HP CSA (https://<CSA_machine>:8444/csa/login).

2. Click Designs > Sequenced > Resource Offerings.

3. Open the resource offering that is used in the design—MOE-2-TIER_SAP or MOE-3-TIER-SAP.

4. Open the Lifecycle tab and click Deploying.

5. Open the flow that exists on the Transition stage.

6. Verify that the timeout is enough for the installation.

7. Do the same for the flow that exists on the Post-Transition stage.

To verify that the Update Process Instance State component exists in the flow:

1. Log on to HP OO Central (https://<oomachine>:8443/oo) > Run Management and select the

Install SAP central system – CSA run.
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2. Verify that the Process Instance State Update step exists.

3. Click this step to verify that the processReturnCode parameter is set to SUCCESS.

4. In case this component does not exist in the flow, you will need to add the following component as

the last component of the flow:

/CSA [4.10.0000]/Library/Integrations/Hewlett-Packard/Cloud Service
Automation/Update Process Instance State

For more details on how to add the component to the flow, refer to "Administration" on page 73.
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Chapter 9: Administration
This section includes the following topics:

Importing Scripts to HP OO Studio 73

Updating OO Installation Script with New Code 74

Modifying the OO Scripts 75

MOE Central Compute – Deploy Script 76

Passing Parameters to HP OO Flow 76

Installing SAP Central System – HP CSA Script 80

Passing Parameters to HP OO Flow 81

Updating the Service with the New Script 84

Replacing MOE Provider with a Different Infrastructure Provider 85

Tested Configurations 87

Importing Scripts to HP OO Studio

Note: The role responsible for this procedure is Operations Staff.

The scripts must be imported to HP Operation Orchestration (HP OO) Studio in order to perform any

update or modification on the scripts.

The zipped folder contains the installation scripts, as well as a provisioning virtual machine using a

HP Matrix Operating Environment (MOE) template.

To import scripts:

1. Unzip OO1002.zip from the R2F – SAP Content Pack.

2. Log on to the HP OO Studio as admin.
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3. In HP OO Studio, click the Import folder button.

4. Browse and select the OO1002 folder. The scripts are imported into the SAP project.

5. Make the required changes on the scripts.

HP CSA will recognize the changes only if they are deployed to HP OO Central. For more details, see

"Modifying the OO Scripts" on the next page.

Updating OO Installation Script with New Code

Note: The role responsible for this procedure is Operations Staff.

From time to time, the installation script of SAP changes, along with new versions and releases. In order

to continue working with the HP Cloud Service Automation (HP CSA) Service Design and the HP OO

installation script, update the script with the new code.

To update the script with the new code:

1. Under /SAP/Library/Hewlett-Packard/Infrastructure orchestration/Service Actions/SAP Business

Applications – CloudMap/Subflows Common MOE, open the Perform Installation Unix subflow.

2. Open the Inputs window of the Create and Send local installation script to remote host

component.
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3. Open the file_content input, save its content for a backup, and change it to the new code.

4. Save the script.

5. Update HP OO Central for HP CSA to recognize the changes.

For more information, see "Modifying the OO Scripts" below.

Modifying the OO Scripts
This section contains the following topics:

MOE Central Compute – Deploy Script 76

Passing Parameters to HP OO Flow 76

Installing SAP Central System – HP CSA Script 80

Passing Parameters to HP OO Flow 81

Updating the Service with the New Script 84

Note: The role responsible for modifying all of the OO Scripts is Operations Staff.

This section describes what the components are in the scripts that allows the connection between

HP OO and HP CSA and the connection between HP OO and MOE.
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To better understand the logic on these scripts, how the parameters are transferred from the

Sequenced Design on HP CSA to the HP OO flow are described in this section.

MOE Central Compute – Deploy Script

This script is based on the MOE Simple Compute – Deploy script which comes as part of the oo10-csa-

moe content pack and was modified in order to enable transformation of the newly virtual machine

details to the installation script.

The script reads the value of the SAP System ID (SID) property as described in the previous section and

uses it as a prefix of the hostname of the new created virtual machine.

Then it executes the MOE template, based on the template name that was set on the

templateReference property on the HP CSA design.

After the execution completes, the HP OO script updates the HP CSA Service.

Two additional HP CSA components are created at this point—Server Group and Server (as its child).

The virtual machine details (hostname and IPaddress) are set on the new HP CSA Server component

properties, as well as on the HP CSA Infrastructure Service component, in order for the installation

script to recognize these properties.

Passing Parameters to HP OO Flow

Two subflows are responsible for recognizing the HP CSA properties:

l Get User Identifier

l Get Artifact Properties
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To Pass Parameters to the HP OO Flow:

1. The Get User Identifier subflow recognizes the HP CSA properties.

Select the Results tab and verify that the userIdentifier result exists. If not, add a new result—

userIdentifier—from the Result Field.

2. To show the OO flow which component on the HP CSA design template to look at, on the Properties

tab,add a new input to the script called SVC_COMPONENT_ID.
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3. Create a new property in the HP CSA design template and send the SVC_COMPONENT_ID token as a

value.

4. Make the following changes to Get Artifact Properties:

a. Change the artifactId input value to SVC_COMPONENT_ID.
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b. After setting which HP CSA design template component to look at, use the propertyValue input

of Get Artifact Properties to set which property values you want to read.

To do this:

i. Change the propertyValue input value for all of the properties sent from HP CSA,

separated by a | sign.

ii. Add all the properties returned as results of this subflow.

iii. For each one of them, create two filters:
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and

Now you can use these parameters on the OO flow.

Installing SAP Central System – HP CSA Script

The installation script reads the value of all of the properties on the HP CSA design template and

performs the installation based on the parameters sent by the user.

After the installation is finished, it updates the installation information with the SAP System ID and the

SAP Master Password that was automatically generated as part of the installation process.
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Passing Parameters to HP OO Flow

Two subflows are responsible for recognizing the HP CSA properties:

l Get User Identifier

l Get Artifact Properties

To Pass Parameters to the HP OO Flow:

1. The Get User Identifier subflow recognizes the HP CSA properties.

Select the Results tab and verify that the userIdentifier result exists. If not, add a new result—

userIdentifier—from the Result Field.
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2. To show the OO flow which component on the HP CSA design template to look at, on the Properties

tab,add a new input to the script called SVC_COMPONENT_ID.

3. Create a new property in the HP CSA design template and send the SVC_COMPONENT_ID token as a

value.
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4. Make the following changes to Get Artifact Properties:

a. Change the artifactId input value to SVC_COMPONENT_ID.

b. After setting which HP CSA design template component to look at, use the propertyValue input

of Get Artifact Properties to set which property values you want to read.

To do this:

i. Change the propertyValue input value for all of the properties sent from HP CSA,

separated by a | sign.

ii. Add all the properties returned as results of this subflow.
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iii. For each one of them, create two filters:

and

Now you can use these parameters on the OO flow.

Updating the Service with the New Script

If changes are made on an HP OO script that the HP CSA already recognizes, then the changes must be

uploaded to HP OO Central.

To upload changes to HP OO Central:

1. Create a new content pack from the first level folder.

2. Deploy the content pack to HP OO Central as described in "Deploying Content to HP OO Central" on

page 42.
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If you added a new script and HP CSA does not recognize it, run the Process Definition Tool as explained

in "Registering Workflow to be Used in HP CSA" on page 44.

Replacing MOE Provider with a Different Infrastructure
Provider

Note: The role responsible for this procedure is Service Designer.

In the design we created, we used MOE as a provider for the infrastructure level. This can be changed to

any other infrastructure provider, such as vCenter.

To replace the MOE provider with a different provider:

1. Create a new Resource Offering for the new provider.

2. Open the lifecycle of the resource provider and add the relevant deploy flow—for example,

vCenter Simple Compute – Deploy—to the Deploying > Transition stage.

Note: The deploying OO flowmust return the new virtual machine details (hostname, IP

address, and management IP address) to the infrastructure level on the service design.

3. Add the related SAP installation flow (central or distributed) to the Deploying > Post-Transition

stage.

4. Add the Delete system and Delete application server flows to the Un-Deploying > Pre-Transition

stage.
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5. Add an Un-deploy flow—for example, vCenter Simple Compute – Un-deploy—to the Un-Deploying

> Transition stage.

6. Open the desired service—Provision SAP Central System or Provision SAP Distributed System.

7. Click the Infrastructure Service component and open the Resource Bindings tab

8. Remove the MOE-related resource offering, and add the desired resource offering that you

created in the previous steps.
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Tested Configurations

Application
Name

Database
Vendor

Operating
System

SAP
Flavor

Ins.
Directory

SAP

Version

Central System

SRM Oracle LINUX ABAP BS7i2013-
SR1

BS2013SR1

CRM Oracle LINUX ABAP BS7i2013-
SR1

BS2013SR1

ERP Oracle LINUX ABAP BS7i2013-
SR1

BS2013SR1

SRM Max-DB LINUX ABAP BS7i2013-
SR1

BS2013SR1

SRM Max-DB LINUX ABAP BS7i2013-
SR1

BS2013SR1

SRM Oracle LINUX ABAP BS7i2013-
SR2

BS2013SR2

Distributed System

SRM Oracle LINUX ABAP BS7i2013-
SR1

BS2013SR1
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Chapter 10: Abbreviations
ABAP Advanced Business Application Programming

ALM HP Application Lifecycle Management

BAPI SAP Business Application Programming Interfaces

BSM HP Business Service Management

CAL SAP Cloud Appliance Library

CI Configuration Item

CCMS Computing Center Management System

CMA Custom Message Attributes

CMDB Configuration Management Database

CMS Configuration Management System

CRM SAP Customers Relationship Management software

D2C HP Detect to Correct Value Stream

ERP SAP Enterprise Resource Planning software

EUM HP Business Service Management's End-User Monitoring

HI Health Indicator

HP OMi HP Operations Management

HPOM HP Operations Manager

HP OO HP Operations Orchestration

ITSM IT Service Management

JCO Java Connector

KM Knowledge Management

KPI Key Performance Indicator

LMDB SAP Landscape Management Database

LVM Landscape Virtualization Management

MAI SAP Solution Manager Monitoring and Alert Interface
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NIC Network Interface Controller

PI Process Integration

RC HP Release Control

RFC Request for Change

RTSM Runtime Service Model

SAP SPI HP Operations Manager SAP Smart Plug-in

SAPINST SAP Installation Programs

SCM SAP Supply Chain Management software

SM Service Manager

TBEC Topology-Based Event Correlation

SMSSMEX HP Service Manager Incident Exchange

UCMDB HP Universal CMDB

UD HP Universal Discovery
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Chapter 11: Resources
l HP OO – SAP Integration v1.00.00 SAP Integration Guide

(http://support.openview.hp.com/selfsolve/document/KM1412611)

l HP Request to Fulfill Concept and Configuration Guide

(https://softwaresupport.hp.com/group/softwaresupport/search-result/-

/facetsearch/document/KM01491937)

l HP Software Solution and Integration Portal (http://cssg.bbn.hp.com:7878/results/index.html)

l HP SAP Cloud Maps Technical White Paper

(http://h22168.www2.hp.com/us/en/partners/sap/cloudmaps-sap.aspx)

l SAP Installation Guide: see SAP Service Marketplace (service.sap.com)

l SAP NOTES (http://service.sap.com/notes)

l SAP System sizing: Quick sizer tool (http://service.sap.com/sizing)

l SAP Solution Manager (support.sap.com/solutionmanager)

Note: An automatically installed SAP System, in addition to incorporating the newest SAP patches,

must be configured with SAP Solution Manager via SAP Change Management or other SAP change

automation methods.

For more information about integrating with SAP Solution Manager, visit the HP Software Support Online

Web site at: http://www.hp.com/go/hpsoftwaresupport
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Additional Online Resources
Troubleshooting & Knowledge Base accesses the Troubleshooting page on the HP Software Support

Web site where you can search the Self-solve knowledge base. Choose Help > Troubleshooting &

Knowledge Base. The URL for this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site enables you to browse the

Self-solve knowledge base. You can also post to and search user discussion forums, submit support

requests, download patches and updated documentation, and more. Choose Help > HP Software

Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user and sign in. Many also

require a support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to:

http://h20229.www2.hp.com/passport-registration.html.

HP Software Web site accesses the HP Software Web site. This site provides you with the most up-to-

date information on HP Software products. This includes new software releases, seminars and trade

shows, customer support, and more. Choose Help > HP Software Web site. The URL for this Web site is

www.hp.com/go/software.

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site

enables you to explore HP Product Solutions to meet your business needs, includes a full list of

Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is

http://support.openview.hp.com/sc/solutions/index.jsp.

HP SAP Cloud Maps: The Best Practices described here leverage and modify HP Operation Orchestration

(HP OO) flows to be used inside SAP Cloud Maps developed within the HP Enterprise Group SAP

development lab. This Best Practice document has the flows adjusted to match the overall

HP Software-driven best practices.The Shellscripts that perform the actual SAP deployments are also

leveraged.

For additional background information and restrictions related to the original Cloud Maps flows that are

used and modified, as well as Shellscript and SAP Installation prerequisites and restrictions, see

Implementing the HP Cloud Map for SAP Business Applications

(http://h22168.www2.hp.com/us/en/partners/sap/cloudmaps-sap.aspx).

Most of the tips and tricks to install SAP automatically will now be found in this R2F for SAP document.
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Additional information is contained in the Cloud Maps document, which was written specifically for

HP CloudSystem 7 and SAP. The Cloud Maps document may still provide add-on information, but much of

the information is CloudSystem 7 compliant and redundant for the newer technologies that HP and SAP

supply.
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